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K O M P U T E R  E N T H U S I A S T S  O F  G R E A T E R  S E A T T L E  

K . E . G . S . 

Prez Says: Ron Cowger 
 
Do you sometimes get as frustrated with digital equipment as I do?  As I have related to 
you in an earlier column, I bought a very nice 13” Sony laptop computer after the General 
Meeting that we held at the Microsoft Store in Bellevue.  I very much enjoyed its very fast 
operation and handy portability for about two months until I suffered the famous Blue 
Screen of Death the evening of March 21st.  At the time of the failure I was just reading a 
news article on the Yahoo web site and I suddenly got the BSD with numerous lines of 
confusing error codes.  One of them suggested that I try a restart so I did.  During the re-
start, the computer displayed an unusual screen asking me to work on the RAID configura-
tion.  That seemed odd since I didn’t even know that my laptop was configured with a 
RAID setup.  It turns out that it uses RAID 0 to incorporate two drives to appear as one.  
After trying several restarts and getting the confusing interruption each time, I decided that 
the computer needed some professional help.  The next day I took it back to the Microsoft 
Store and exercised the warranty that I had purchased with the unit.  As of this writing, I 
have been informed that I should be able to get it back Friday morning.  I’ll let you know 
next month if the fix was successful. 
 
I hope that each of you found the information that Bill Butler presented on RAW Capture 
to Finished Image at the March meeting both interesting and useful.  We all owe Bill a big 
Thank You for filling in at the last minute when Steve could not make it to the meeting.  I 
understand that those who are serious and talented with working with digital photography 
feel strongly that starting with RAW images gives them the best opportunity to get a fin-
ished photo with the best resolution and adjustments.  I genuinely admire folks who can do 
that and wish I had the time and understanding to work on our photos in that manner.  I 
anticipate that Bill probably convinced some of you that using RAW was the best way to 
go.  I’m told that he is a true expert and am sorry that I missed the presentation. 
 
As you recall, Steve gave us some great info at the February General Meeting about his 
favorite and/or most effective utilities for trouble shooting, repairing and configuring com-
puters.  He had a lot of information to cover and didn’t get through it all.  Therefore, Steve 
has kindly agreed to continue his discussion at the April General Meeting.  He will have 
his usual Technology Corner SIG starting at 6:00 on the 11th and then present more infor-
mation about trouble shooting utilities and configuration applications starting at 7:00.  I 
know that I got a lot of good information from Steve’s presentation before and I’m confi-
dent that we will all benefit from the continuation of the discussion this month. 
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We are still pursuing the order for our new KEGS vests.  We have placed the order with 
Costco and have been working on three subsequent drafts of the logo that the embroi-
dery subcontractor has provided.  Judy Panjeti has worked hard on getting the best pos-
sible product available.  At this time I do not have a projected delivery date.  As I re-
ported earlier, in addition to the green vests, the Board has decided to order twelve of 
the vests in gray as there seems to be enough interest in that color to justify satisfying 
the demand. 
 
Again, this month there are two new tips from Sharon Parq Associates added to our 
monthly newsletter.  There is one for using Word and the other for Excel, each designed 
to expand our knowledge of these applications.  If you want access to additional tips 
from this company, you can go to their websites at word.tips.net or excel.tips.net.  I 
think you’ll find the information interesting and useful. 
 
The most recent figures from John Tate indicate that forty-six previous members have 
renewed their KEGS memberships for 2011.  Additionally, we have one new member.  I 
hope that those of you that didn’t get around to renewing yet will do so as soon as possi-
ble.  Renewal forms are available from John Tate, our Treasurer, or you can fill out the 
form on the KEGS web site, print it out and send it along with your check to the address 
shown on the form.  An even easier way would be to bring your completed form and 
your check/cash to the next General Meeting and give it to John there. 
 
That’s it for now.  I will see you at the General Meeting or at your favorite SIG.  I wish 
you happy and safe computing! 

Ron Cowger 
President 



Inserting the User's Address 
Word automatically maintains several items of information about you, as a user. One such item is 
your address, which is changed on the User Information tab of the Options dialog box. If you want to 
automatically insert the user address in your documents, you can follow these steps: 

1. Position the insertion point where you want the address inserted. 
2. Make sure the Insert tab of the ribbon is selected. 
3. In the Text group, click Quick Parts. You’ll see a drop-down menu. 
4. Choose Field. Word displays the Field dialog box. 
5.  In the Categories drop-down list, choose User Information.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Field dialog box. 

6. In the Field Names list choose UserAddress. 
7. Click on OK to close the dialog box and insert your field. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word 
tips can be found online at http://word.tips.net. 
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Word Tip of the Month 



 
Copying Values 
 

There are many ways that you can use Excel's tools to fill out various cells in a worksheet. One 
of the most common tools is to copy a cell (or cells) and then paste them into other cells. The 
only problem with this approach is that when you copy cells, you also copy the format of the 
original cells into the target cells. What if you just want to copy the values from the original 
cells, but retain the formatting already applied in the target cells? 

You probably already know that you can use the Paste Special option from the Home tab of the 
ribbon (Excel 2007 and 2010) or the Edit menu (older versions of Excel), and then choose the 
Values option to paste just the values. If the target cells are right next to the original cells, there 
is an even easier way to accomplish the same task. Simply follow these steps: 

1. Select the original cells whose values you want to copy. 
2. Right-click on the fill handle (at the bottom right-corner of the selection) and drag the 

selection to encompass the target cells. When you release the mouse button, a Context 
menu appears. 

3. Choose the Fill Values option. Excel fills the target cells with the values from the 
original cells; the formatting remains unchanged. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft 
Excel tips can be found online at http://excel.tips.net. 
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KEGS General 
Meeting 
And Associated SIGs 

KEGS T-shirts 
Remember, you score extra KEGABUCK$ 
when you wear your KEGS shirts to SIGS 
and the General Meetings!  (NOTE: This 
extra credit is not honored at the PIG SIG.) 

We still have a few left of various sizes.  
Then we will order more.  So why wait?  
Pick yours up at the next general meeting. 

Day of Month Time Location  SIG / Email contact  SIG Leader 

2nd Monday 6 PM - 7 PM Kirkland Teen Union 
Building 

Technology Corner 
   betacode@hotmail.com 

Steve Fondren 

2nd Monday 7 PM - 9 PM Kirkland Teen Union 
Building 

KEGS General Meeting  

2nd Monday 9:30 PM - ? 
PM 

Outback Steakhouse 
12120 NE 85 th, Kirkland 

Pig SIG 
   sallyannmowrey@msn.com 

Sally Ann Mowrey 
206-996-5635 

General Meetings at the Kirkland Teen Union Building - 348 Kirkland Ave., Kirkland, WA 98033 

DRIVING INSTRUCTIONS: From I-405, take the N.E. 85th ST. exit (exit number 18) toward KIRK-
LAND (headed West).  Immediately move to the center lane and take a left at the first light onto 
Kirkland Way (If you went right you would be on 114th Ave NE).  Just stay on Kirkland Way and it 
will turn into Kirkland Ave.  

The Kirkland Teen Union Building is part of a string of connected buildings.  Right at the street is 
Kirkland's Performing Arts Center, then comes the Kirkland Senior Center and farthest from the 
street is The Kirkland Teen Union Building. 

There is a parking area to the West of this building but you can also park in the Kirkland Library's 
covered parking area just a little farther to the West ( 1/4 block past the Performing Arts Center). 

mailto:betacode@hotmail.com�
mailto:sallyannmowrey@msn.com�


KEGS SIG Meetings: 
KEGS T-shirts 
Remember, you score extra 
KEGABUCK$ when you wear 
your KEGS shirts to SIGS and the 
General Meetings!  We still have 
a few left of various sizes.  
Then we will order more.  So 
why wait?  Pick yours up at the 
next meeting. 

NEW SIG CHART 
Notice that this SIG chart  no longer lists actual dates.  Please check our KEGS calendar (at 
http://www.kegs.org/Calendar.html) for actual dates AND POSSIBLE CANCELLATIONS of 
the upcoming meeting that you want to attend. 

Contact the SIG leaders to find out what presentations that they have planned for their up-
coming meetings. 

Meetings at the North Bellevue Community / Senior Center - 4063  148th Ave NE, Bellevue, WA  

Day of Month Time Location  SIG / Email contact  SIG Leader 

1st Wednesday 7 PM - 9 PM Conf. room D Seattle Internet User Group 
   seasigi@kegs.org 

Marianne Wilkins 

2nd Tuesday 7 PM - 9 PM Computer Lab Computer Support SIG - N. Bellevue 
   j_m_mraz@hotmail.com 
(Computer repair & maintenance) 

Joe Mraz 
425-747-2433 

2nd Wednesday 7 PM - 9 PM Conf. room D Computer Use and Optimization 
   ctheprof@aol.com 

Carl Von Papp 
425-643-1398 

3rd Tuesday 7 PM - 9 PM Conf. room D Servers. Networks and Storage 
   daviddodge1@compuserve.com 

David Dodge 

3rd Wednesday 7 PM - 9 PM Conf. room D Small Office / Home Office (SOHO) 
   r_cowger@prodigy.net 

Ron Cowger 

4th Tuesday 7 PM - 9 PM Conf. room D Digital Imaging SIG 
   sallyannmowrey@msn.com 

Sally Ann Mowrey 
206-996-5635 

4th Wednesday 7 PM - 9 PM Conf. room D KEGS Board Meeting 
      r_cowger@prodigy.net 

Ron Cowger 

1st Tuesday 7 PM - 9 PM Conf. room D HTML SIG 
   jackbewitch@comcast.net 

Jack Beslanwich 
206-723-9960 

     

http://www.kegs.org/Calendar.html�
mailto:jackbewitch@comcast.net�
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mailto:j_m_mraz@hotmail.com�
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Please note that the KEGS Board meetings are not held at our General Meeting or SIG  
meeting locations 
• KEGS Board Meetings are currently held at The North Bellevue Community / Senior Cen-

ter - 4063  148th Ave NE, Bellevue, WA  Conf. Rm D, 7-9 PM on the 4 Wed. of the 
month (Board meetings are public and open to anyone who wants to attend.) 

SIG Meeting Locations: 

Finding our primary SIG meeting location 
 

DRIVING INSTRUCTIONS: Thanks to the improvements to SR 520, you may now use the new 
NE 40th St exit. If you are driving towards Redmond, exit and turn left to go over the over-
pass. If you are coming from Redmond, exit and turn right. Go to 148th Ave NE, and turn 

right. In very short order, you will see the North Bellevue Community / Senior Center sign on 
the left side of the roadway. 

KEGS was formed in late 1996 to meet the needs of personal computer users in the Greater 
Seattle Area. KEGS is a nonprofit organization that holds its general meetings on the second 
Monday of each month.  
In addition, KEGS sponsors a number of special interest groups (SIGs) that meet regularly 
to share common interests, learn new techniques, and resolve questions about the use of per-
sonal computer hardware, accessories, or software. 

History & Contact info: 

For a detailed listing of our SIG’s, up-
dated information about KEGS activities, 
and more, please see our web site at:  
 
              http://www.kegs.org. 

 Contact us at: Email: info@kegs.org 
 The Komputer Enthusiasts of Greater Seattle  
 PMB# 195  
 677 120th Ave NE, Suite 2A  
 Bellevue, WA 98005     
 Or call 425-747-2433 before 9 PM 

To submit articles or software reviews for incorporation into this Newsletter, please send them 
to:   newsletter@kegs.org 
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